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Typographic Conventions

Table 1

N

<Example>

Angle brackets indicate that you replace these words or characters with appropriate entries
to make entries in the system, for example, “Enter your <User Name>".

b Example » Example 3

Arrows separating the parts of a navigation path, for example, menu options

Example

Emphasized words or expressions

Example

Words or characters that you enter in the system exactly as they appear in the
documentation

WWW.Sap.com e

Textual cross-references to an internet address

/example Quicklinks added to the internet address of a homepage to enable quick access to specific
content on the Web
123456 A Hyperlink to an SAP Note, for example, SAP Note 123456 A
Example ®  Words or characters quoted from the screen. These include field labels, screen titles,
pushbutton labels, menu names, and menu options.
® Cross-references to other documentation or published works
Example ®  Qutput onthe screen following a user action, for example, messages
®  Source code or syntax quoted directly from a program
® File and directory names and their paths, names of variables and parameters, and
names of installation, upgrade, and database tools
EXAMPLE Technical names of system objects. These include report names, program names,

transaction codes, database table names, and key concepts of a programming language
when they are surrounded by body text, for example, SELECT and INCLUDE

EXAMPLE Keys on the keyboard
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Document History

A Caution

Before you start the implementation, make sure you have the latest version of this document. You can find the

latest version at the following location: service.sap.com/instguides # .

Table 2
rsonJowe ——Jowerpien
1.00 2013-06-14 New content SAP AC 10.1, PC 10.1, RM 10.1 (initial release).
12 2013-08-29 Updates to topic Configuring the SAP NetWeaver Gateway
1.3 2013-11-15 Updates:
e Added reference to SAP Fiori. to Introduction
e  SAP NetWeaver version changed from SPO2 to SPO4
®  Revised Section 6.4: Configuring the SAP NetWeaver Gateway
® Revised Sections 3.2,3.5,3.6
1.4 2013-12-19 Updates to topic Configuring the SAP NetWeaver Gateway
15 2014-12-18 Updates to NetWeaver version
16 2016-05-03 Removed chapter Installing the SAP NetWeaver Portal Components
1.7 2016-05-26 Removed GRCPINW from the required plug-in list for SAP Risk Management.
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1 Introduction

SAP Access Control 10.1, Process Control 10.1, and Risk Management 10.1 are part of the SAP solutions for
governance, risk, and compliance (GRC).

For more information, see www.sap.com/grc #.

SAP Access Control 10.1

SAP Access Control is an enterprise software application that enables organizations to control access and
prevent fraud across the enterprise, while minimizing the time and cost of compliance. The application
streamlines compliance processes, including access risk analysis and remediation, business role management,
access request management, emergency access management, and periodic compliance certifications. SAP
Access Control delivers immediate visibility of the current risk situation with real-time data.

SAP Process Control 10.1

SAP Process Control is an enterprise software solution for internal controls management. It enables organizations
to document their control environment, test and assess controls, track issues to remediation, and certify and
report on the state and quality of internal controls. Using a combination of data forms, automated workflows,
certification, and interactive reports, this solution enables members of internal control, audit, and business
process teams to manage compliance activities.

SAP Risk Management 10.1

SAP Risk Management is an enterprise software solution that enables organizations to balance business
opportunities with financial, legal, and operational risks to minimize the market penalties from high-impact
events. The application allows customers to identify these risks and monitor them on a continuous basis.
Stakeholders and owners are provided with such tools as analytic dashboards for greater visibility in mitigating
risks in their areas of responsibility.

11 About this Document

This guide describes how to install SAP solutions for governance, risk, and compliance; that is, SAP Access
Control 10.1, SAP Process Control 10.1, and SAP Risk Management 10.1.

1.2 SAP Notes for the Installation

Read the following SAP Notes before you start the installation. These SAP Notes contain the most recent
installation information, as well as any corrections to the installation documentation.
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1 Note

Make sure that you have the latest version of each SAP Note, which you can find on SAP Service Marketplace at

service.sap.com/notes .

Table 3

1855332 e

Release Strategy for SAP Access
Control 10.1

This SAP Note contains information
about planning the installation and
upgrades of the ABAP add-on.

1814403 A

WDA: Syntax Error When Activating A
Web Dynpro Component

This mandatory SAP Note must be
applied after you install SAP NetWeaver
7.40 SPO2 to make sure that the SAP
NetWeaver Business Client (NWBC) is
working properly.

A Caution

Apply this note when you install or
when you upgrade to the 10.1
release.

1855403

GRCFND_A V1100 Installation and
Upgrade

This SAP Note contains general
information about how to install and
upgrade SAP solutions for governance,
risk, and compliance 10.1.

1855404 e

GRCPINW V1100 Installation and
Upgrade

This SAP Note contains information
about planning the installation and
upgrading of the SAP NetWeaver Plug—
In.

1855405 e

GRCPIERP V1100 Installation and
Upgrade

This SAP Note contains information
about planning the installation and
upgrading of the SAP GRC ERP Plug—In.

1597627 A

SAP HANA Connection

This SAP Note contains information
about how to set up a second database
connection from your system to an SAP
HANA system.

1353044 rtr

Installation Guide: Crystal Report
Adapter

This note contains information about
installing a front-end component to
integrate SAP Crystal Reports with the
Advanced List View (ALV).

1366785

SAP Crystal Reports ALV Integration —
Functional Restrictions

This note describes the functional and
nonfunctional restrictions of the
integration of SAP Crystal Reports into
ABAP List Viewer (ALV).

CUSTOMER

© Copyright 2016 SAP SE or an SAP affiliate company.

6 All rights reserved.

SAP Access Control™, SAP Process Control™, and SAP Risk Management™10.1
Introduction



http://help.sap.com/disclaimer?site=https%3A%2F%2Fservice.sap.com%2Fnotes
http://help.sap.com/disclaimer?site=http%3A%2F%2Fservice.sap.com%2F~form%2Fhandler%3F_APP%3D01100107900000000342%26_EVENT%3DREDIR%26_NNUM%3D1855332%26_NLANG%3Den%26_NVERS%3D0
http://help.sap.com/disclaimer?site=http%3A%2F%2Fservice.sap.com%2F~form%2Fhandler%3F_APP%3D01100107900000000342%26_EVENT%3DREDIR%26_NNUM%3D1814403%26_NLANG%3Den%26_NVERS%3D0
http://help.sap.com/disclaimer?site=http%3A%2F%2Fservice.sap.com%2F~form%2Fhandler%3F_APP%3D01100107900000000342%26_EVENT%3DREDIR%26_NNUM%3D1855403%26_NLANG%3Den%26_NVERS%3D0
http://help.sap.com/disclaimer?site=http%3A%2F%2Fservice.sap.com%2F~form%2Fhandler%3F_APP%3D01100107900000000342%26_EVENT%3DREDIR%26_NNUM%3D1855404%26_NLANG%3Den%26_NVERS%3D0
http://help.sap.com/disclaimer?site=http%3A%2F%2Fservice.sap.com%2F~form%2Fhandler%3F_APP%3D01100107900000000342%26_EVENT%3DREDIR%26_NNUM%3D1855405%26_NLANG%3Den%26_NVERS%3D0
http://help.sap.com/disclaimer?site=http%3A%2F%2Fservice.sap.com%2F~form%2Fhandler%3F_APP%3D01100107900000000342%26_EVENT%3DREDIR%26_NNUM%3D1597627%26_NLANG%3Den%26_NVERS%3D0
http://help.sap.com/disclaimer?site=http%3A%2F%2Fservice.sap.com%2F~form%2Fhandler%3F_APP%3D01100107900000000342%26_EVENT%3DREDIR%26_NNUM%3D1353044%26_NLANG%3Den%26_NVERS%3D0
http://help.sap.com/disclaimer?site=http%3A%2F%2Fservice.sap.com%2F~form%2Fhandler%3F_APP%3D01100107900000000342%26_EVENT%3DREDIR%26_NNUM%3D1366785%26_NLANG%3Den%26_NVERS%3D0

1382730 7

SAP Crystal Reports ALV Integration —
Troubleshooting

This note helps you to analyze problems
that you might encounter with the
integration of SAP Crystal Reports into
the Advanced List Viewer ALV.

Read the SAP Notes below if your environment includes more than one component (SAP Access Control, SAP
Process Control, or SAP Risk Management) from the SAP solutions for governance, risk, and compliance (GRC).

Table 4

1470670

User-defined Fields for RM

The Note describes how to customize
user-defined fields in SAP Risk
Management.

1505255 fr

Transfer client-specific Customizing for
PC/RM

Transfer the client-specific Customizing
from the delivery client for SAP Process
Control 10.1 and SAP Risk Management
10.1.

1509639 A

Preparation for Installing GRC-RM 2010

For installation of SAP Risk
Management 10.1 or for the upgrade of
a production system from SAP Risk
Management 3.0 to SAP Risk
Management 10.1

A Caution
Review this SAP Note before
attempting the installation.

1519164 e

Create BRF+ application name & ID for
Continuous Monitoring

The BRF+ application name must be
unique to import BRF+ content from a
source system to a target system. The
same BRF+ application name and
application ID must exist in all
environments.

736902 e

Adobe Credentials

If you want to use Adobe Interactive
Forms and you require a credential to
complete the configuration, you need
this note.

The credential is only required if you
have interactive forms (forms in which
the user can enter data). For print
forms, the credential is not required.
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1.3 SAP Fiori Apps

For more information regarding SAP Fiori apps, see SAP Fiori for SAP Access Control 10.1 help.sap.com/grc-ac
A
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2 Planning

Perform the following planning steps before you start the installation.

Procedure

1. Consult the master guides to determine the software components and supporting systems that you want to
run either an SAP Access Control 10.1 only landscape or a multiple componentSAP goverance, risk, and
complicance (GRC) 10.1 solution landscape. Each component has its own master guide in its own section of
the SAP GRC help:

o  Forthe SAP Access Control 10.1 component, consult the SAP Access Control 10.1 Master Guide at

Ik help.sap.com/grc-ac # » Installation and Migration Information 3

o For the SAP Process Control 10.1 component, consult the SAP Process Control 10.1 Master Guide at
Ik help.sap.com/pc % » Installation and Upgrade Information 1

o Forthe SAP Risk Management 10.1 component, consult the SAP Risk Management 10.1 Master Guide at
[k help.sap.com/rm# » Installation and Migration Information 3

2. Download and check the relevant SAP Notes listed in this document.

3. Before you begin your installation, make sure that SAP NetWeaver 7.40 SPO5 (ABAP) is properly installed
and configured as described later in this guide. This step is mandatory.

1 Note

SAP Access Control, SAP Process Control, and SAP Risk Management 10.1 run on SAP NetWeaver 740
SPO5 (on non-HANA or HANA databases).

4. SAP Access Control and SAP Process Control require that you install plug-ins for your ERP system as
directed in this guide.

1 Note

If you want to manage access for HANA, you must install the HANA plug-in. For more information, see the
section of this guide called Installing the SAP HANA Plug-In.

5. If you want to use the SAP NetWeaver Portal, which is not required if you use the SAP NetWeaver Business
Client (NWBC), install the following programs according to the directions in this guide:

o GRCPIERP Portal Plug-In
o GRC_POR_1000 (this replaces NWBC)

6. If youwant to use the document search feature in SAP Process Control and SAP Risk Management (only),
install TREX, by following the directions in this guide.

7. If youwant to use Adobe Document Services, install SAP NetWeaver Java as directed in this guide.
CUSTOMER
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1 Note
To enable printing from SAP software, download the Adobe Document Services license. For more

information, see the SAP Library at help.sap.com % and search on Licensing Adobe Document Services.

Also see SAP Note 736902 & , Adobe Credentials.

If you plan to use Simplified Access Control, ensure that your browser is HTML5 and CSS3 compliant.
Examples of such browsers include Internet Explorer 9, Chrome, and Firefox.
Take all applicable security measures. For more information, see the SAP AC/PC/RM 10.1 Security Guide at

help.sap.com/grc s . Select the desired product and then select Security Information.
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3 Installing the Components

This chapter discusses the various software and tools that you may use in your installation.

3.1 Preparing to Install SAP Solutions for Governance, Risk,
and Compliance (GRC) 10.1

Install SAP solutions for governance, risk, and compliance (GRC) 10.1 on a standalone system as opposed to
installing them along with an SAP Business Suite or with any SAP Business Suite components such as ERP, SCM,
CRM, OR SRM.

3.2 Software Update Manager (SUM)

Software Update Manager (SUM) is an installer that replaces JAVA Service Program Manager (JSPM). SUM is
now the only supported JAVA installation tool; JSPM is no longer supported.

For more information about Software Update Manager, see the following:

® https://service.sap.com/instguides |r Other Documentation » Deployment Optimization Option of SUM
10.0 1.

® scn.sap.com/docs/DOC-25113

3.3 SAP NetWeaver Components

Depending on your landscape configuration, the following SAP NetWeaver components are available to install:

Table 5

Support Package Manager (SPAM) 7.40 or higher N/A

SAP Basis 7.40 SPO5

SAP ABA Cross Application Component 7.40 SPO5

SAP_GWFND SAP - Gateway Foundation 7.40 7.40 SPO5

SAP User Interface Technology 7.40 7.40 SPO6

PI_BASIS - Basis Plug-In 7.40 SPO5

SAP BW - SAP Business Warehouse 7.40 SPO5
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o

GRCFND_A - GRC Foundation ABAP V1100

N/A

DMIS 2010_1_700

2010_1_700 SPO6 (or latest)

(Optional) SAP NetWeaver Application Server Java for Adobe
Document Services

SAP NetWeaver Java is required to use Adobe Document
Services. It must be available in the system landscape, but
does not need to be installed on the same system as the SAP
GRC 10.1 applications.

You must create and activate the following JCo destinations:
e WD_ALV_METADATA_DEST
e WD_ALV_MODELDATA_DEST
Itis essential to create Adobe Credentials; see SAP Note
736902 it , Adobe Credentials.

If problems occur in forms processing, see SAP Note

944221 A for more details about troubleshooting.
For more information, see the following Web

page:www.sdn.sap.com/irj/sdn/adobe fe .

Bl Java Usage Type (part of the SAP NetWeaver Java stack)
to enable the printing of PDFs from Process Control reports
and Risk Management reports.

Bl Java Usage Type must be installed on the same system as
the Adobe Document Services.

For more information, see SAP Notel533060 7 WD ABAP
ALV - create print version.

Standalone Engine

TREX 7.10 (revision 53 or higher)
TREX 7.25 SP24 (SAP HANA)

1 Note

If you use SAP Process Control 10.1 Policy Survey PDFs, be sure to upgrade to the latest version of Adobe

Reader.

3.4 Java Components

The Java components, SAP GRC Portal, and SAP GRC Portal Plug-Ins are supported on all SAP NetWeaver
releases from 7.02 to 7.40. See the software compatibility matrix later in this document to determine the versions
of SAP NetWeaver, SAP GRC Portal Content, and SAP GRC Portal Plug-Ins that work together.

1 Note

The 10.0 version of the Java components is used with the SAP GRC 10.1 system.
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3.5 Downloading SAP Solutions for Governance, Risk, and
Compliance 10.1

Procedure

1. Gotothe SAP Software Distribution Center on SAP Service Marketplace at service.sap.com/swdc .

2. Download the following SAP GRC 10.1 applications and install them using the Software Update Manager
(SUM) or transactions SAINT or SPAM.

Table 6
SAP Access Control |» Software Downloads » Installations and Upgrades # A - Z Index » G » SAP GRC
Access Control » SAP Access Control » SAP Access Control 10.1
SAP Process Control |» Software Downloads # Installations and Upgrades » A - Z Index » P » SAP
Process Control » SAP Process Control 10.1
SAP Risk Management |» Software Downloads # Installations and Upgrades » A - Z Index » R » SAP Risk
Management » SAP Risk Management 10.1 3

3.6 Installing HR and Non-HR Plug-Ins

GRCPINW and GRCPIERP Plug-Ins are used as indicated in the table below. The subsequent table gives
instructions on how to download these Plug-Ins.

Table 7
GRCPINW This Plug-In is used for non-HR functions in SAP Access
Control.
In SAP Process Control, it is used for Continuous Monitoring
(required if you use the ABAP Report, Configurable and
Programmed Sub-Scenarios).
GRCPIERP This Plug-In is used for HR functions in SAP Access Control
and SAP Process Control.
Procedure

Follow the steps below to download the SAP GRC 10.1 Plug-Ins.
1. Gotothe SAP Software Distribution Center on SAP Service Marketplace at https://service.sap.com/swdc.
2. Download SAP GRC 10.1 plug-ins and install them using SUM or transactions SAINT or SPAM.

Use the paths in the table below.
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Table 8

SAP Access Control

|» Software Downloads ¥ Installations and Upgrades ¥ A -
ZIndex » G » SAP GRC Access Control » SAP Access
Control » SAP Access Control 10.1 3

SAP Process Control

|» Software Downloads » Installations and Upgrades » A -
Z Index » P » SAP Process Control » SAP Process Control
10173

SAP Risk Management

b Software Downloads » Installations and Upgrades » A -
ZIndex ¥ R » SAP Risk Management » SAP Risk
Management 10.1 3

3.7 Installing the SAP HANA Plug-In

Install the following Plug-In if you are using the SAP HANA database:

Table 9

Technical name

HCO_GRC_PI

Software Component Version

SAP GRC 10.1 Plug-In SAP HANA

Procedure

You download this plug-in as follows:

1. Goto service.sap.com/swdc A

2. Choose|r Software Downloads » Installations and Upgrades » A - Z Index » G » SAP GRC Access Control »
SAP Access Control » SAP Access Control 10.1 » Installation 3

3. Select the HCO_GRC_PI download object.

More Information

For more information, see SAP Note 1597627 %= SAP HANA Connection.
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4 Installing TREX (Optional)

You can install the standalone version of TREX if you want to use Enterprise Search for document search in SAP

Process Control 10.1 and SAP Risk Management 10.1.

1 Note

TREX is not an option in SAP Access Control 10.1 only environments.

Procedure

1. Toinstall the latest TREX version, see the Master Guide at [p service.sap.com/installnw74 = » SAP
NetWeaver 7.4 1 Installation - Standalone Engines and Clients —Master Guide.

2. For more information, see the following SAP Notes:

Table 10
1249465 A How to install TREX for Embedded Search
1164532 A Limitations
1266024 A Sizing TREX for Embedded Search
1269011 A Additional TREX instance for Embedded Search

SAP Access Control™, SAP Process Control™, and SAP Risk Management™10.1
Installing TREX (Optional)
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5 Post-Installation

After downloading and installing the files described in the previous sections, configure the product by following
the post-installation sections in the order that they are presented.

5.1 Client Copy

Client copy is not required in SAP Access Control 10.1 only environments.

For more information, see SAP Note 2290499 v .

5.2 Activating the Applications in Clients

After the installation is complete and the SAP solutions for governance, risk, and compliance (GRC) 10.1 are in
place, you must activate them in each client.

Procedure

Complete the following steps to activate the applications:

1. Openthe SAP Reference IMG iby going to |» Tools » Customizing » IMG » Execute Project (transaction
SPRO) 1.

Display the SAP Reference IMG.
Choose [ Governance, Risk, and Compliance » General Settings » Activate Applications in Client 1.

Execute Activate Applications in Client.

a > wn

Activate an application component:by following the steps below:

1. Choose the New Entries pushbutton.

2. Select an application component from the dropdown list.
3. Inthe Active column, select the check box for each application that you want to use.
The application component activation is now complete.

1. Choose the New Entries pushbutton.

2. Select an application component from the dropdown list.

3. Inthe Active column, select the check box for each application that you want to use.
The application component activation is now complete.
CUSTOMER
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5.3 Checking SAP ICF Services

Specific Internet Communication Framework (ICF) SAP Services, and SAP GRC services need to be activated.
They are inactive by default after an installation or an upgrade. Check that all the relevant services are active.

For more information about activating these services, see SAP Note 1088717 A, Active services for Web Dynpro
ABAP in transaction SICF.

Procedure

1. Activate each of the following ICF service nodes:
o /sap/public/bc
0 /sap/public/bc/icons
o /sap/public/bc/icons rtl
o /sap/public/bc/its
o0 /sap/public/bc/pictograms
0 /sap/public/bc/ur
o /sap/public/bc/webdynpro
o /sap/public/bc/webdynpro/mimes
o /sap/public/bc/webdynpro/adobeChallenge
0 /sap/public/bc/webdynpro/ssr
o /sap/public/bc/webicons

0 /sap/public/myssocntl

1 Note
You can also activate all ICF services within:
0 /sap/public

o /sap/bc

© /sap/grc —for Access Control 10.1 only environments

2. Activate all GRAC, GRPC, and GRRM services.

3. Activate all services under /sap/bc/webdynpro/sap.

5.4 Configuring the SAP NetWeaver Gateway

In order to use some of the new functionality in SAP Access Control 10.1, such as the Remediation View in SAP
Access Risk Analysis, an SAP NetWeaver Gateway connection must be established. Follow these steps to
maintain or verify the connector.

CUSTOMER
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Procedure

10.

11.

12.
13.
14.
15.
16.

18

Logon to an SAP NetWeaver system and access the SAP Reference IMG as follows: from the SAP Easy
Access menu, choose |F Tools » Customizing » IMG » Execute Project (transaction SPRO) 1.

Choose [r SAP Reference IMG » SAP NetWeaver » Gateway » OData Channel » Configuration » Connection
Settings » SAP NetWeaver Gateway to SAP System 1.

Choose Manage RFC Destinations and create an RFC (communication) destination that points to the system
itself.

Caution
Be sure to specify the proper RFC Type, client, and user information using the naming convention:

<System SID>CLNT<Client Number>;for example, GD1CLNT200.

If you are using Single-Signon, choose Define Trust for SAP Business Systems. Complete the fields with the
information you provided in the Step 3.

1 Note

This step only applies if you are using Single-Signon.

Choose Manage SAP System Aliases to create the system alias for the RFC destination that you created in
Step 3.

Choose New Entries and enter the following values:

Table 11

Field Name What You Enter

SAP System Alias Enter the name of the RFC destination that you created in
Step 3.

Description Enter a description that is meaningful to your installation.

RFC Destination Enter the name of the RFC destination that you created in
Step 3.

Software Version Choose the value DEFAULT from the drop down list.

Save your entries.

If required, choose Activate or Deactivate SAP NetWeaver Gateway to activate the SAP NetWeaver Gateway
Services.

Choose [r SAP NetWeaver » Gateway » OData Channel » Administration » General Settings 1.

Choose Activate and Maintain Services. The system displays a list of all the services that have been created in
the backend system.

Click to select the Technical Service GRAC GW VIOLSUMM REM SRV.

In the System Aliases section (bottom right-hand corner), click Add System Alias.
Enter GRAC_GW_VIOLSUMM REM SRV_0001 as the Service Doc. Identifier.

For the SAP System Alias, enter the system alias name that you created in Step 6.
Click the check box for Default System.

Save your entries.
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17. On the Activate and Maintain Services screen, in the ICF Node section (bottom left-hand corner), verify that
the traffic light in front of the ICF Node is green. If it is not, click the ICF Node field and select Activate from
the ICF Node dropdown menu.

18. If required, Save your settings.

19. You may need to perform additional activations depending on what has already been activated in your
environment. To do so, on the Activate and Maintain Services screen, repeat steps 11 through 18 for the
following services:

Table 12
/IWFND/SG_MED_CATALOG CATALOGSERVICE /IWFND/SG_MED_CATALOG_0001
/IWFND/SG_USER_SERVICE USERSERVICE /IWFND/SG_USER_SERVICE_000O
1 Note
This step is optional. It may not be required in some environments where the services have already been
activated.

More Information

For more information, see the SAP Help portal at help.sap.com s and search for: SAP NetWeaver Gateway
Developer Guide. Then choose [ OData Channel » Basic Features » Service Life-Cycle » Activate and Maintain
Services 1.

5.5 Maintaining System Data

Complete the Add-On Product Version in your system data application so that customer support can see which
SAP solutions for governance, risk, and compliance (GRC) applications are implemented in your environment.

For more information, see SAP Note 1313108 4, System Data Maintenance for GRC Process Control.

Procedure

1. Goto SAP Service Marketplace at service.sap.com A . Locate the System Data application in the Support
Portal under Data Administration.

Use one of the search functions provided to select an installed SAP system.
On the System tab, scroll down to the Add-On Product Version section.

Insert a line.

o M 0D

Select the SAP Access Control 10.1 support package, SAP Process Control 10.1 application support package,
or the SAP Risk Management 10.1 application support package from the list.

o

Save your changes.

Repeat this procedure for all SAP systems.

CUSTOMER
SAP Access Control™, SAP Process Control™, and SAP Risk Management™10.1 © Copyright 2016 SAP SE or an SAP affiliate company.
Post-Installation All rights reserved. 19


http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com
http://help.sap.com/disclaimer?site=http%3A%2F%2Fservice.sap.com%2F~form%2Fhandler%3F_APP%3D01100107900000000342%26_EVENT%3DREDIR%26_NNUM%3D1313108%26_NLANG%3Den%26_NVERS%3D0
http://help.sap.com/disclaimer?site=http%3A%2F%2Fservice.sap.com

Activating Crystal Reports

To use the Crystal Reports function, activate the flag Allow Crystal Reports in Customizing under [» SAP
NetWeaver » Application Server » SAP List Viewer (ALV) » Maintain Web Dynpro ABAP-Specific Settings 3.

5.6 Maintaining Plug-in Settings

Once you install the plug-in components, Non-HR (GRCPINW), and, optionally, HR (GRCPIERP), you must
maintain the plug-in user exit and configuration settings.

Procedure

In the IMG activity below, you maintain the user exit settings that are required to run Risk Terminator in Role
Maintenance (transaction PFCG). Risk Terminator enables real time risk analysis while making changes to role
authorizations or role assignments in the Plug-In system.

1. Openthe SAP Reference IMG from [ Tools » Customizing » IMG » Execute Project (transaction SPRO) 1.
2. Display the SAP Reference IMG.

3. Open|r Governance, Risk, and Compliance (Plug-In) » Access Control 1.

4

Maintain the necessary IMG activities for your system according to the instructions in the IMG
documentation that is located at the left of each of the following IMG nodes:

o Maintain User Exits for Plug-in Systems

©  Maintain Plug-in Configuration Settings
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6 Customizing with Business Configuration
(BC) Sets

You activate Business Configuration (BC) sets after the software is installed. BC sets are delivered
implementation toolsets that simplify the Customizing process. You need to activate some or all of the BC sets
that are delivered with SAP solutions for governance, risk, and compliance 10.1.

See the following sections in this guide for the specific BC sets for SAP Access Control, SAP Process Control, and
SAP Risk Management 10.1.

1 Note

For SAP Access Control 10.1 only environments, you only activate the SAP Access Control BC Sets.

Caution

You can activate a BC set only if that client is not a production client. When you activate the BC set, all data in
the BC set is transferred into the corresponding tables and any existing entries are overwritten.

= Recommendation

Always consult with the functional experts for your application before activating any of the BC sets.

See SAP Solution Manager for information about Customizing activities at service.sap.com/solutionmanager e .

For more information about BC sets, see |p help.sap.com/nw70 7 » Application Help » SAP NetWeaver » SAP
NetWeaver by Key Capability » Solution Life Cycle Management by Key Capability » Customizing » Business
Configuration Sets (BC-SETS) 1

6.1 Activating BC Sets

Procedure

1. Fromthe SAP Easy Access screen, choose |F Tools » Customizing » IMG » Execute Project » SAP Reference
IMG 3

2. Choose Existing BC Sets from the toolbar in the Implementation Guide to identify all of the IMG activities that
have BC sets.

3. Select one of these IMG activities and choose the BC Sets for Activity button.
The system displays the contents of the BC set in a new window.

4. To activate this BC set, choose the pull-down menu ¢ Go to » Activation Transaction 1.
Select the icon for Activate BC Set (or use F7).
The Activation Options screen opens.

6. Choose Continue.
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A completion message appears: Activation successfully completed. If a yellow informational message
appears, choose Enter and then the completion message appears.

1 Note

A message with a yellow background is only a warning and you can proceed. A message with a red
background is an error message and you must resolve the error. If you receive a Basis error message with a
red background, contact your system administrator.

Caution

The following information does not applywhen activating BC sets in SAP Access Control 10.1 only
environments.

Caution

When activating the BC set tables that begin with GRPC-ATTR-*, errors may appear in the Progress
column.

7. You must activate the following five BC sets twice:
© GRPC-ATTR-CTRL OBJ CATEGORY
O  GRPC-ATTR-CTRL_GROUP
© BC_SET RISK LEVEL MATRIX
O GRFN-PNS-FDA

0  GRFN-PNS-SOX

1 Note

You can ignore the following error messages during first-time activation:

Table 13

N

1 GRPC-ATTR-CTRL GROUP VC GRPCATTR Table/View V_GRPCATTRVALUEZ2: higher-
level entry for & missing

2 GRPC-ATTR-CTRL GROUP VC GRPCATTR Entry xxxXx xxxx does not exist in
GRPCATTRVALUE (check entry).

3 GRFN-PNS-FDA Entry FDA does not exist in GRPC MCF REGCONF (check entry).

4 GRFN-PNS-SOX Entry SOX does not exist in GRPC MCF REGCONF (check entry).

Second-time activation may produce warning messages that can safely be accepted if no error message
occurs.

6.2 SAP Access Control BC Sets

The following tables list the BC sets for SAP Access Control 10.1 categorized by type. BC sets marked with an
asterisk (*) indicate that you can also activate them in Customizing.
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= Recommendation

Always consult with the SAP Access Control functional experts before activating the BC sets for rules such as
Segregation of Duties (SoD)to determine which rule sets are relevant for your implementation.

Table 14

BC Set BC Set Name

Specific to Access Risk Analysis

GRAC RA RULESET COMMON SoD Rules Set
GRAC RA RULESET JDE JDE Rules Set
GRAC RA RULESET ORACLE ORACLE Rules Set
GRAC RA RULESET PSOFT PSOFT Rules Set
GRAC RA RULESET SAP APO JDE Rules Set

GRAC RA RULESET SAP BASIS

SAP BASIS Rules Set

GRAC_RA RULESET SAP CRM

SAP CRM Rules Set

GRAC_RA RULESET SAP_ECCS

SAP ECCS Rules Set

GRAC RA RULESET SAP HR

SAP HR Rules Set

GRAC_RA RULESET SAP NHR

SAP R/3 less HR Basis Rules Set

GRAC_RA RULESET SAP R3

SAP R/3 AC Rules Set

GRAC_RA RULESET SAP SRM

SAP SRM Rules Set

Specific to Access Request Management

GRAC ACCESS REQUEST REQ TYPE¥

Request Type

GRAC ACCESS REQUEST EUP*

EUP (Note: Only the value EU ID 999 is valid for this BC
set.)

GRAC_ACCESS REQUEST APPL MAPPING*

Mapping BRF Function IDs and AC Applications

GRAC_ACCESS REQUEST PRIORITY*

Request Priority

GRAC DT REQUEST DISPLAY SECTIONS

Simplified Access Request Display Sections

GRAC DT REQUEST FIELD LABELS

Simplified Access Request Field Labels

GRAC DT REQUEST PAGE SETTINGS

Simplified Access Request Page Settings

Specific to Business Role Management

GRAC_ROLE_MGMT SENTIVITY*

Sensitivity

GRAC_ROLE MGMT METHODOLOGY*

Methodology Process and Steps

GRAC ROLE MGMT ROLE S TATUS* Role Status
GRAC_ROLE MGMT PRE REQ TYPE* Prerequisite Types
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BC Set BC Set Name

GRAC ROLE SEARCH COFIGURATION

Role Search Configuration for Access Request

Specific to Superuser Management

GRAC_SPM CRITICALITY LEVEL*

Criticality Levels

Specific to Workflow

GRC_MSMP CONFIGURATION*

MSMP Workflow Configuration Rules Set

6.3 SAP Process Control BC Sets

You need to activate the following BC sets (categorized by type) that are delivered with SAP Process Control 10.1:

Table 15

SAP Process Control-specific generic BC sets

GRPC-AGENTSLOTC-GLOBAL

Global Roles to Receive Tasks in Workflow

GRPC-ROLE-CROSS-REG

Role Assignment for PC Cross Regulation Roles

GRPC-SCOPE-MAT-ANA-FREQ

Scoping Materiality Analysis Frequency

GRPC-SCOPE-IMPACT-LEVEL

Impact Levels

BC_SET PROBABILITY LEVEL ID

Maintain Probability Level ID

BC_SET RISK LEVEL MATRIX

Maintain Risk Level Matrix

1 Note
Before activating this BC set, first activate
BC_SET PROBABILITY LEVEL ID.

GRPC-SCOPE-CNTL-RISK-FACTOR

Control Risk Factor

GRPC-SCOPE-CNTL-RATE-RNG

Control Rating Range

GRPC-SCOPE-LVL-EVID-VAL

Level of Evidence Value

GRPC-SCOPE-LVL-EVID

Level of Evidence

BCSET-GRRM-GRRMVRISKOPPLVL

Maintain Risk and Opportunity Levels

GRPC-BP-ATTR-VALUE

Business Process Attribute Values

GRPC-ATTR-ASSERTION

Financial Assertions

GRPC-ATTR-CATEGORY

Control Category

GRPC-ATTR-CTRL_ FREQUENCY

Frequency of Control Operation
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GRPC-ATTR-CTRL_GROUP

Control Group and Subgroup

GRPC-ATTR-CTRL_OBJ CATEGORY

Control Objective Category and Control Type

GRPC-ATTR-IELC-FREQ

Indirect Entity-Level Control Operation Frequency

GRPC-ATTR-INDUSTRY

Industry

GRPC-ATTR-NATURE

Nature of Control

GRPC-ATTR-PURPOSE

Control Purpose

GRPC-ATTR-RELEVANCE

Control Relevance

GRPC-ATTR-RISK IMPACT

Quialitative Risk Impact

GRPC-ATTR-SAMPLE METHOD

GRPC: Add New Sampling Method to BC Set

GRPC-ATTR-SCHED FREQUENCY

Scheduling Frequency

GRPC-ATTR-SIGNIFICANCE

Control Significance

GRPC-ATTR-TEST TECH

Test Technique

GRPC-ATTR-TRANSTYPE

Transaction Type

GRPC-RPTRES-S0OX

User Responsible for Reporting Entity- SOX

GRPC-RPTRES-FDA

User Responsible for Reporting Entity- FDA

GRPC-RESP-USER-SOX-UPG

Upgrade-BC Set of SOX Agent Determination Rules

GRPC-RESP-USER-FDA-UPG

Upgrade-BC Set of FDA Responsible Person

SAP Process Control FDA-specific BC sets for FDA regulations

GREFN-PNS-FDA

Plan Usage — FDA

1 Note

Before activating this BC set, first activate GRPC-MCF -
FDA.

GRPC-AGENTSLOTC-FDA

FDA Roles to Receive Tasks in Workflow

GRPC-MCF-FDA

Regulation/Policy — FDA

GRPC-ROLE-FDA

Roles for Regulation/Policy FDA

1 Note
Before activating this BC set, first activate GRPC-MCF -
FDA.

SAP Process Control BC sets for SOX regulations:

GRFN-PNS-SOX

SAP Access Control™, SAP Process Control™, and SAP Risk Management™10.1

Customizing with Business Configuration (BC) Sets

Plan Usage — SOX
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1 Note
Before activating this BC set, first activate GRPC-MCF -
SOX.

GRPC-AGENTSLOTC-SOX

SOX Roles to Receive Tasks in Workflow

GRPC-MCFEF-SOX

Regulation/Policy — SOX

GRPC-ROLE-SOX

Roles for Regulation/Policy SOX

1 Note
Before activating this BC set, first activate GRPC-MCF-
SOX.

1 Note

The following BC sets must be activated twice:

® GRPC-ATTR-CTRL OBJ_ CATEGORY (Control Objective Category and Control Type)

® GRPC-ATTR-CTRL_GROUP (Control Group and Subgroup)

6.4 Shared BC Sets (SAP Process Control and SAP Risk

Management)

You need to activate the following BC sets that are delivered with SAP Process Control 10.1 and SAP Risk

Management 10.1
Table 16

GRFN-AHISS-CAPA-REG-CRS

Enable CAPA by Regulation Type for Cross Regulation
Entities

GRFN-AHISS-OBJECT

Enable Ad Hoc Issues by Object Type

GRFN-AHISS-SOURCE

Maintain Ad Hoc Issue Sources

GRFN-AHISS-SOURCE-ENTITY

Assign Ad Hoc Issue Sources to Entity Types

GRFN-ALLOW-CREATE-LOCAL-CTRL

Maintain Possibility to Add Local Controls to Local
Subprocess

GREN-POLICY-ACKN-OPTION

Define acknowledgment option

GREN-POLICY-APPROVAL

Define Policy Approvals

GREN-POLICY-CATEGORY

Maintain Policy Categories

GRPC-AMF-MENUITEM-UPGRADE
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(for upgrade customers only)
1 Note

This BC set must be activated twice.
GRFN-WORKFLOW-NOTIFICATION Maintain Workflow Notifications
GRPC-FREQUENCY Timeframe Frequencies
GRPC-TIMEFRAME Timeframes
BC SET BENEFIT CATEGORY Maintain Benefit Category
GRPC-RISK-DRIVER-CATEGORY Driver Category of Risk Attributes
GRPC-RISK-IMPACT-CATEGORY Impact Category of Risk Attributes
BCSET-GRRM-GRFNV_DEC SETUP Define Probability and Maximum Score
BCSET-GRRM-GRRMVRISKOPPLVL Maintain Risk and Opportunity Levels
BC-SET RISK PRIORITY ID Maintain Risk Priority ID

1 Note

If you are using Internal Audit Management functionality, ensure that the following BC Sets are activated:
e BCSET-GRRM-GRFNV_DEC_SETUP

e BCSET-GRRM-GRRMVRISKOPLVL

e BC-SET_RISK_PRIORITY_ID

These BC sets are used by the audit risk rating function of Internal Audit Management when setting risk score,
risk level, and risk priority for an auditable entity.

6.5 SAP Risk Management BC Sets

You need to activate the following BC sets that are delivered with SAP Risk Management 10.1:

Table 17
e

BC SET ANALYSIS PROFILE Maintain Analysis Profile

BC-SET ACTIVITY TYPES Maintain Activity Types

BC SET BENEFIT CATEGORY Maintain Benefit Category

BC SET DEFINE CATEGORIES POWL Maintain Categories for POWL

BC SET DEFINE THREE POINT ANALYS Define Three Point Analysis

BC SET DRIVER CATEGORY Maintain Driver Category
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BC SET IMPACT CATEGORY

Maintain Impact Category

BC SET IMPACT LEVEL

Impact and Risk Levels

BC-SET INFLUENCE STRENGTH

Define Influence Strength

BC SET MAINTAIN DEFAULT QUERY

Maintain Default Query for POWL

BC-SET MAINTAIN OPP_RESP TYPES

Maintain Opportunity Response Types

BC SET MAINTAIN USER RESP

Maintain Users Responsible for Entity

BC SET OBJECTIVE CATEGORIES

Maintain Objective Category

BC SET PROBABILITY LEVEL ID

Maintain Probability Level ID

BC SET PROBABILITY LEVEL MATRIX

Maintain Probability Level Matrix

BC-SET RESPONSE EFFECTIVENESS

Maintain Response Effectiveness

BC-SET RESPONSE TYPE

Maintain Response Type

BC SET RISK APETITE

Maintain Risk Appetite

BC_SET RISK LEVEL

Impact and Risk Levels

BC SET RISK LEVEL MATRIX

Maintain Risk Level Matrix

BC SET RISK PRIORITY MATRIX

Maintain Risk Priority Matrix

BC_SET ROLES

BC Set for Roles

BC SET SPEED OF ONSET

Maintain Speed of Onset

BC-SET LOSS MATRIX COLORS

Incident Loss Color Matrix

BC SET UNIT MEASURE

Maintain Units of Measures

BC-SET RISK RESPONSE TYPE

Maintain Risk Response Type Combination

BCSET-GRRM-GRENV_POLICYTYPE

Maintain Response Relevance for Policy Types

BCSET-GRRM-GRRMVPOLICYRESP

Link Policy Status and Response Completeness
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7 SAP Enterprise Portal Configuration

7.1 Creating a System Connection with the SAP Enterprise
Portal

For information about how to create an SAP Enterprise Portal system connection for SAP Access Control 10.1,

SAP Process Control 10.1, and SAP Risk Management 10.1, follow the path:lk help.sap.com/nw70 # » Application
Help » SAP Library » SAP NetWeaver » SAP NetWeaver by Key Capability » People Integration by Key Capability »
Portal » Portal Administration Guide » Super Administration » Pre-configured Roles » Administration Roles »
Workset: System Administration 3

For optimum display of the portal, choose the relevant portal configuration required depending on your license
configuration. Select portal configuration for SAP Access Control 10.1-only license users or for SAP solutions for
governance, risk, and compliance (GRC) multiple application license users (AC10.1 + PC10.1 + RM10.1 or any
combination of two applications).

1 Note

SAP provides a set of sample roles that include the recommended authorizations. You can create your own
PFCG roles or copy the sample roles to your customer namespace and then modify them as needed.

For more information about the delivered roles for, see the Security Guide for SAP Access Control 10.1 / SAP

Process Control 10.1 / SAP Risk Management 10.1 at help.sap.com/grc# . Choose your application, then
choose ¢ Security Information » Security Guide 1.

7.2 Portal Configuration for SAP Access Control 10.1- Only
Licensed Users

The list below contains the system and portal aliases roles that you configure if you only have SAP Access Control
10.1in your system landscape.

e System Aliases:

o The system alias must use SAP-GRC, SAP-GRC-AC, and SAP_GRC.
® Portal Roles:

© Assigntherole GRC ACCESS CONTROL to users.

o Assigntherole ERP COMMON to everyone in the user group.
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7.3 Portal Configuration for SAP Solutions for GRC- Licensed
Users

If your system landscape contains more than one GRC component (SAP Access Control 10.1, SAP Process
Control 10.1, or SAP Risk Management 10.1), you configure the system aliases and portal roles as follows:

System Aliases

Table 18
GRC Component System Alias Configuration
If SAP Access Control 10.1is activated: The system alias must use SAP-GRC, SAP-GRC-AC, and
SAP_GRC.
If SAP Process Control 10.1is activated: The system alias must use SAP-GRCand SAP-GRC-PC, and
SAP_GRC
If SAP Risk Management 10.1 is activated: The system alias must use SAP-GRC and SAP-GRC-RM, and
SAP_GRC.
Portal Roles
Table 19
User GRC SUITE
Everyone in the user group ERP COMMON
User, if needed GRC Internal Audit Management
1 Note

For SAP Access Control 10.1 only environments, you must assign the GRC Access Control role to at least
one user.

7.4 Creating the Initial User in the ABAP System

SAP solutions for governance, risk, and compliance (GRC) 10.1 uses various roles to interface with the SAP
system. This section explains how to create your initial ABAP system user for SAP Access Control 10.1, SAP
Process Control 10.1, and SAP Risk Management 10.1.

1 Note

This section uses the delivered roles as examples only. As you complete the procedure, you must replace the
delivered roles with equivalent roles in your customer namespace.
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Procedure

SAP Access Control 10.1

To create an initial user in the ABAP system for SAP Access Control 10.1:

1.

Assign all SAP Access Control users the role SAP_ GRAC BASE so they can access the SAP Access Control
10.1 applications.

Assign the role SAP GRAC ALL to the user who will perform Customizing. This role is the power user role. It
gives the designated user the ability to see and do everything without being assigned to a specific SAP
Access Control role. This role is typically assigned to the user who creates the organization structures and
assigns the business roles to all the other users.

1 Note

The role does not contain the authorizations for Workflow Customizing, Case Management, or web
services activation. For these authorizations, use the role SAP GRAC SETUP.

Caution
Assign the sap_GRAC_ALL role carefully, since a user assigned to this role can make pervasive changes.
For more information on the SAP_GRAC ALL role and its authorizations, see the SAP AC/PC/RM 10.1
Security Guide at:|p help.sap.com/grc# » Access Control » Security Information » Security Guide 3.

Using transaction su01, create a user.

If this user needs to receive workflow notifications via e-mail, on the Address data tab, assign an e-mail
address and a Comm. Meth of E-Mail to the user.

Onthe Roles tab, assign the roles SAP_GRAC BASE and SAP_GRAC_ALL to this user.

This user can now use transaction SpPrO to complete the Customizing configuration including such steps as
activating the Business Configuration (BC) sets and assigning roles to other users

SAP Process Control 10.1 and SAP Risk Management 10.1

To create initial users in the ABAP systems for SAP Process Control 10.1 and SAP Risk Management 10.1 follow
the steps below:

1.

Assign all SAP Process Control and SAP Risk Management users to the role SAP_ GRC_FN_BASE to allow
them to access the SAP Process Control or SAP Risk Management applications.

Assign the sSAaP_GRC_FN_ALLrole to the user doing the Customizing of the product. This role is the power
user role. It gives the designated user the ability to see and do everything without being assigned to a specific
SAP Process Control or SAP Risk Management role. This role is typically assigned to the person who creates
the organization structures and assigns business roles to all the other users. It contains all of the
authorizations from the role SAP_ GRC_FN BUSINESS USER in addition to the following authorizations:

o Administrative functions in the SAP Process Control Implementation Guide (IMG), and the SAP Risk
Management IMG

o Structure setup in expert mode
©  Dataupload for structure setup
o Customizing table maintenance for SAP Process Control and SAP Risk Management 10.1

o Initiation of role assignment procedures
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The role does not contain the authorizations for Workflow Customizing, Case Management, or web services
activation. For these authorizations, use the role SAP GRC SPC_SETUP.

Caution
Assign the sAP_ GRC_FN_ALL carefully, since a user assigned to this role can make pervasive changes.
For more information about the SAP GRC FN ALL role and its authorizations, see the SAP AC/PC/RM 10.1
Security Guide at: |» help.sap.com/grc# » choose your product » Security Information » Security Guide 1.

Using transaction su01, create a user.

If this user needs to receive workflow notifications via e-mail, on the Address data tab, assign an e-mail
address and a Comm. Meth of E-Mail to the user.

5. Onthe Roles tab, assign the roles SAP_ GRC_FN BASE and SAP_GRC_FN ALL to this user.

This user can now use transaction SPrO to complete the Customizing configuration steps such as activating the
BC sets and assigning roles to other users.

7.5 Creating the Initial User in the SAP NetWeaver Portal

The navigation tabs and work centers for SAP Access Control 10.1, SAP Process Control 10., and SAP Risk
Management 10.1 are defined in the portal roles that are maintained in the SAP GRC portal package.

After creating the portal user, the portal administrator must assign to that user the SAP GRC 10.1 portal roles.
These portal roles enable the user to see the SAP GRC navigation and work centers tabs.

1 Note

This section uses the delivered roles as examples As you complete the procedure, you must replace the
delivered roles with equivalent roles in your customer namespace.

Procedure

SAP Access Control 10.1

Log on as the portal user administrator and access the User Administration function.

2. [Ifauser has already been created by the User Management Engine (UME) thatis connected to the SAP
GRC ABAP system, you do not need to create a user in the portal system.

If a user has not been created by the User Management Engine (UME), create a new portal user and assign
the SAP GRC ABAP system to the user in the User Mapping for System Access tab, along with a mapped user
ID and password.

3. Gotothe Assigned Roles tab and assign the role GRC Suite (name: pcd:portal content/com.sap.pct/
com.sap.grc.grac/com.sap.grc.ac.roles/com.sap.grc.ac.Role All)tothe user who has the
power user role SAP GRAC_ALL in the ABAP system. This role enables the power user to view the work
centers.

SAP Process Control 10.1 and SAP Risk Management 10.1
1. Logon as the portal user administrator and access the User Administration function.
CUSTOMER
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2. Ifauser has already been created by the User Management Engine (UME) thatis connected to the SAP
GRC ABAP system, you do not need to create a user in the portal system.
If a user has not been created by the UME, create a new portal user and assign the SAP GRC ABAP system to
the user in theUser Mapping for System Access tab, along with a mapped user ID and password.

3. Gotothe Assigned Roles tab and assign the roleGRC Suite (name: pcd:portal content/
($installedpath$) /com.sap.grc.GRC_Suite/com.sap.grc.GRC_Suite Role/
com. sap.grc.GRC) to the user who has the power user role SAP_GRC_ALL in the ABAP system. This role

enables the power user to view the work centers.

More Information

For more information about the visibility of work centers, see the SAP AC/PC/RM 10.1 Security Guide at
IF help.sap.com/grc e » choose your product » Security Information » Security Guide 1.

This information is based on the technologies delivered by SAP NetWeaver Portal. For more information, see the
Portal Security Guide athelp.sap.com/saphelp_spm?21_bw/helpdata/en/5c/429f00al4aa54195blc63ae1512d10/

frameset.htm e .
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